
TTP: Email Migration
DEE (mail.mil) to A365 EXO (army.mil)
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This how-to guide covers email migration from 
DEE to A365 EXO for those who are self-migration 

eligible or assisted migration eligible. Email 
Migration should be executed while connected 

directly to an unclassified Army network.

Click the logo above to 
suggest corrections or changes. Click here to view this and other Army 365 How-To Guides! Version 4 | 20210909

mailto:a365-ttp-wg@armyeitaas.onmicrosoft.us?subject=A365%20TTP%20Suggestion%20/%20Correction
https://armyeitaas.sharepoint-mil.us/teams/Army365HowToGuides/SitePages/Army-365-How-To-Guides.aspx
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Before You Start… 

Please read through this how-to guide completely 
before starting your migration activity. 

The migration of your email data may appear intimidating, but the following processes 
have been evaluated and used successfully by many Army 365 Early Adopters. 

Many users can complete self-migration within an hour. 

If at any point you are unsure of the instruction given or a screenshot/description 
doesn’t match what you’re seeing please stop and consult an Army 365 Champion or 

your IT support provider for assistance.
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1. The first step is to identify which one of 
two migration methods you need to 
pursue. To do this, open a web browser 
(Edge or Chrome recommended) and 
navigate to EXO Webmail at 
https://webmail.apps.mil

2. Enter your A365 account into the sign-in 
prompt as shown and click next. Your 
A365 address is the same as your 
Enterprise Email except the domain at the 
end is @army.mil.  The next step will take 
you to the DoD Global Directory sign-in 
page. 

3. Select Sign in with CAC/PIV and choose 
your Authentication certificate.

4. If prompted to ‘stay signed in’ choose Yes
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Identifying Your Migration Eligibility [1]

https://webmail.apps.mil/


If you are presented with the Exchange 
Online (EXO) webmail interface similar to 
the image in Figure A then you are:

Self-Migration Eligible
Click the link above to view instructions for 
Self-Migration.

If you are presented with “Error 500: 
Something went wrong. We couldn’t find a 
mailbox for this account…” as shown in 
Figure B then you are:

Assisted Migration Eligible
Click the link above to view instructions for 
Assisted Migration.
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Identifying Your Migration Eligibility [2]

FIGURE A: 
You are Self-
Migration Eligible

FIGURE B: 
You are Assisted 

Migration Eligible

+ You don’t see Figure A or B? Stop here and contact your supporting IMO or A365 Champion.



Before you get started, please review and complete the 
Mailbox Cleanup steps found in the links below. This will 
reduce the amount of redundant or unnecessary data that 
is copied to your army.mil. You may need to hold Ctrl on 
your keyboard and then click the links to open in browser.

1) Attachments Cleanup

2) Calendar Cleanup

3) Redundant Threads Cleanup

1.  Launch Outlook 2016. Click File at the top-left corner of 
the screen, then click on Account Settings and Accounts 
Settings again as shown to the right.

2.  In the Account Settings window with E-mail Tab 
selected, ensure your mail.mil account is highlighted 
and click Change…

3.  In the Change Account window move the Mail to keep 
offline: slider to the end to enable All. This ensures that 
all email data is able to be transferred. Click Next. 
If prompted to restart Outlook for changes to take effect 
please click OK and restart.

UNCLASSIFIED

Self-Migration: Add army.mil in Outlook [1]

example@mail.mil

example@mail.mil

https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/Shared%20Documents/Outlook%20Cleanup%20-%20Attachments.pdf?web=1
https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/Shared%20Documents/Outlook%20Cleanup%20-%20Calendar.pdf?web=1
https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/Shared%20Documents/Outlook%20Cleanup%20-%20Redundant%20Threads.pdf?web=1


4.  Back at the Account Settings window, click 
New… to add your army.mil mailbox.

5.  In the Add Account window use the Auto 
Account Setup by inputting your army.mil
address. This is the same as your mail.mil 
address but the domain name changes 
from “mail.mil” to “army.mil”. Click Next.

6. When prompted, select Sign in with 
CAC/PIV and choose your Authentication
certificate. Input your CAC PIN if required.

7. If successful you’ll receive the Congratulations
window shown at right. Click Finish to continue. 
If prompted to restart Outlook please do so.
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Self-Migration: Add army.mil in Outlook [2]

example@mail.mil

+ If you receive an error at Step 7 please contact your IMO or A365 Champion for support.



8. In Outlook you should now see both mailboxes (note: you 
may need to collapse other PST files or group mailboxes to 
find the new army.mil mailbox). Check the bottom-right 
corner of the Outlook window; if it shows Updating Inbox, 
Updating Folder, or Updating youraccount@mail.mil then 
please wait for the syncing to complete before you 
continue. This may take a while!

9. At the bottom-left corner in Outlook, click on the ellipsis 
(three dots) button and then select Folders. This will present 
your mailbox data as folders for simple transfer.

10. Click to select the Inbox. Hold Ctrl and press A on the 
keyboard to select all email data in the folder. Right-click on 
any highlighted email and select Move, then Copy to Folder. 
In the Copy Items prompt expand your army.mil mailbox and 
select the Inbox. Repeat this process for Drafts, Sent Items, 
and Tasks.

11. Easily transfer custom folders (created and named by the 
user) by right-clicking the folder name and selecting Copy 
Folder. In the Copy Folder prompt select the army.mil 
mailbox and click OK. Calendar and Contacts transfer is 
covered on the next page. 
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Self-Migration: Transferring your data [1]

example@mail.mil

example@mail.mil

example@army.mil

example@army.mil

Move Folders

Move Emails

example@army.mil



12. Select the Calendar folder in your mail.mil mailbox.

13. Click the View tab at the top menu bar, click Change 
View, then select List. 

14. Hold the Ctrl key, then press A to select All Calendar 
Items in List View – the items should be highlighted.

15. Hold the Ctrl key, then click on the list and drag the list 
of calendar items to the Calendar folder under your 
army.mil calendar on the left toolbar. Depending on 
the amount of calendar data it may take some time to 
transfer – be patient.

16. Select the Contacts folder in your mail.mil mailbox. 
Repeat steps 13-16 to drag & drop-copy your mail.mil 
contacts and contact groups to your army.mil mailbox.
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Self-Migration: Transferring your data [2]
example@mail.mil

example@mail.mil example@mail.mil

Contacts - example@army.mil



17. Once you’re finished copying data between 
mailboxes, compare the data now in your 
army.mil folders with the data in your 
mail.mil folders to ensure all needed data has 
been copied over. Meetings that are present 
on your mail.mil calendar should be present 
on your army.mil calendar as well, and your 
Contacts should be identical across both 
mailboxes. 

Note: Due to A365 Teams notifications 
routing to your army.mil account the 
Inbox/Unread quantity may be higher than in 
your mail.mil; the quantity should not be 
lower!

If there are discrepancies such as items 
missing in army.mil folders please repeat the 
copy steps from the previous pages. It may 
also help to restart Outlook or sometimes 
you just need to wait for the data to sync 
with Exchange servers.   Be patient!
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Self-Migration: Transferring your data [3]

example@mail.mil example@army.mil

example@mail.mil example@army.mil



18. With the Home tab selected and while viewing 
your mail.mil mailbox, click the Rules button 
and select Manage Rules & Alerts…

19. If you have any E-mail Rules configured here 
you can export them. Click Options.

20. From the Options window click Export Rules…

21. Give your backup file a name and save it in the 
default location by clicking Save.

22. Click on the Inbox under your army.mil 
account and repeat steps 18-19. This time, 
select Import Rules… and double-click the 
backup file you created.
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Self-Migration: Export E-Mail Rules
example@mail.mil



23. With the Home tab selected and while viewing 
your mail.mil mailbox, click the Rules button and 
select Manage Rules & Alerts…

24. Click on New Rule… to open the Rules Wizard

25. Click Apply rule on messages I receive, then Next

26. Select received in a specific date span. Click on 
the blue, underlined condition in the “Step 2” 
area, then check the box for After and set the 
date to yesterday. Click OK, then Next.
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Self-Migration: Enable redirect to army.mil [1]
example@mail.mil



27. Select redirect it to people or public group. Click on 
the blue, underlined condition in the “Step 2” area 
to input your army.mil address.

28. From the Rule Address window, click in the To line 
and input your army.mil address using one single 
quote (apostrophe) at the start and one at the end, 
e.g.   ‘example@army.mil’
!!! It will not work without the single quotes !!!

29. When prompted to enter Exception Triggers click 
Next to skip. 

30. You can name the rule if you’d like, then make sure 
the Turn on this rule box is checked before clicking 
Finish to enable redirection of all emails addressed 
to your mail.mil to go to your army.mil address.

31. To verify the redirect is working, send an email to 
yourself or ask a coworker to send one to you. 
Sometimes Outlook has a delay, so the best way to 
check is using https://webmail.apps.mil to confirm 
that the redirected test email arrives.
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Self-Migration: Enable redirect to army.mil [2]

Mail Redirect

‘example@army.mil’
Note the apostrophes!

If “redirect it to” shows Lastname, Firstname PTC 
USARMY XXX it will not work! This must show 
first.m.last.ptc@army.mil enclosed in single quotes.

https://webmail.apps.mil/


32. Close Outlook if it’s running. In the 
Windows Search Bar next to the 
Windows Start Menu, type Control 
Panel and hit Enter to open the app 
that appears

33. In the Windows Search at upper-right 
corner of the Control Panel window 
type in “mail” and hit Enter

34. From the results, click on Mail (32-bit)

35. From the Mail Settings window, click 
on Show Profiles
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Self-Migration: Remove DEE From Outlook / Add EXO [1]
When you are certain you have all of your data transferred 
and the email rule to redirect is working then you are ready to 
remove your mail.mil account from Outlook and start using 
army.mil exclusively. Please proceed with steps below.



name@army.mil

36. Click Add, then type a name for your profile. 
It can be anything you want, but it is 
recommended to identify it as “Army 365” 
somehow. Make sure this profile is in the 
dropdown for Always use this profile.

37. The Add Account wizard appears. It should 
automatically populate your name and email 
based on your Active Directory user account 
attributes. Edit your email address to 
@army.mil and leave password fields blank. 
Click Next. Note:  You must be on the DoDIN
to connect a mailbox; it will usually fail over 
VPN. Once the mailbox is initially setup then 
future access is possible over VPN.

38. You’ll be presented with a sign-in window. 
Make sure the address is your @army.mil, then 
click Sign in with CAC/PIV. Select your 
Authentication certificate. 
If you do not see “U.S. Dept of Defense” 
window shown to the right your system may 
not be configured to support Army 365 
authentication with Outlook. Please restart 
your computer and try again, then contact your 
IT support provider if problem persists.
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Outlook

Self-Migration: Remove DEE From Outlook / Add EXO [2]



UNCLASSIFIED

39. If you receive the “Congratulations!” message 
to the right you have successfully connected 
your Army 365 Mailbox to Outlook 2016. Click 
Finish to continue.  If this step fails please 
restart your computer and try again, then 
contact your IT service provider if problems 
persist.

40. Launch Outlook 2016. You will be presented 
with another authentication prompt. Select 
Sign in with CAC/PIV and choose your 
Authentication certificate.

41. You may need to wait several minutes while it 
connects and downloads mailbox contents, but 
then you should ONLY see your A365 EXO 
mailbox listed in the folder view to the left in 
Outlook 2016.

Self-Migration: Remove DEE From Outlook / Add EXO [3]
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42. To enable decryption and digital 
signing of emails, you’ll need to 
configure your email security 
settings. Click File in the top-left 
corner of Outlook.

43. Select Options.

44. Select Trust Center.

45. Select Trust Center Settings.

46. Select Email Security.

47. Select Settings…

Self-Migration: Configure Settings for A365 EXO Email [1] 
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48. Select New, and name the configuration. 
It can be anything you want, but it is 
recommended to identify it as “Army 365” 
somehow. 

49. Check the box for “Default Security 
Setting for this cryptographic message 
format”.

50. Under Certificates and Algorithms, click 
Choose… next to the Signing Certificate
and select your Signature certificate. 
Choose SHA1.

51. Under Certificates and Algorithms, click 
Choose… next to the Encryption 
Certificate and select your Encryption
certificate. Choose AES (256-bit).

52. Click OK when finished. You should now 
be able to open encrypted emails 
received in your EXO mailbox.

Self-Migration: Configure Settings for A365 EXO Email [2]
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53. At the Trust Center Email Security 
window, verify that your army.mil 
configuration is set as Default Setting, 
then select Publish to GAL… Click OK to 
confirm and input your PIN if prompted. 
Click OK at the final confirmation window.

54. Close the Trust Center and return to the 
Mail tab. Scroll down to the Send 
Messages section and click on Empty 
Auto-Complete List… to remove cached 
entries for mail.mil recipients.  This will 
prevent sending of emails to 
undeliverable cached addresses.

55. Back at the main Outlook window click 
New Email, then the Insert tab. Select 
Signature, then Signatures… to enable 
your default email signature(s).

Self-Migration: Configure Settings for A365 EXO Email [3]

If you don’t see the 
Publish to GAL… button 
please go back to Page 15, 
Step 36 and ensure you are 
accessing a profile that 
contains ONLY the army.mil 
account.
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After migration to A365 EXO Email you may still connect to and use most 
DEE (mail.mil) Non-person Entities (NPEs) such as Organizational 
Mailboxes and Group Calendars. As soon as all owners and members of 
an NPE have migrated the NPE should be migrated to army.mil by 
submitting on the EXO Portal.

a) Temporarily enable “legacy authentication” by opening the 
Software Center and look for an application similar to the one to the 
right. Names will vary based on your IT service provider, but should 
reference something like “DEE Outlook Fix”. Install/reinstall this 
application and wait a moment for it to finish. You must complete 
the next steps within 60 minutes or you will likely need to run the 
DEE Outlook Fix again.

b) Open Control Panel, search Mail, click on Mail (32-bit), then click 
Show Profiles… 

c) With your A365 profile highlighted click on Properties then click 
E-mail Accounts… 

d) On the E-mail tab select New…, then at the Auto Account Setup 
screen input the NPE address that you want to add, such as 
usarmy.pcs.cmd.mbx.a365@mail.mil, then click Next. At the 
certificate selection prompt choose the Authentication certificate 
and enter PIN if prompted. Once all mailboxes are added please 
restart your computer.

Add DEE Mailboxes Post-Migration

Army365 Profile

Army365 Profile

usarmy.pcs.cmd.mbx.a365@mail.mil

example@mail.mil

a

b

c
d

https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/


UNCLASSIFIED

GLOBAL ADDRESS LIST
To send from your army.mil to other mail.mil addresses you must type 
the recipient’s mail.mil address in the first time you send to them post-
migration. The Global Address List in A365 only lists army.mil addresses 
and picking recipients from the list will only send to their army.mil 
accounts.  Once you’ve sent to a mail.mil recipient one time they will be 
available from the autocomplete picklist for convenience. You can use 
the A365 GAL to look up a user, then use Properties and reference the 
Alias attribute; simply append mail.mil at the end.

ENCRYPTED EMAIL
You cannot send encrypted from army.mil to mail.mil without the 
recipients’ public key. Send without encryption unless it is needed to 
protect confidentiality of sensitive information. If you must send 
encrypted, ask the mail.mil user to send you a digitally 
signed/encrypted email first, then you can reply to them with an 
encrypted email and will be able to compose new encrypted emails to 
them again in the future. If necessary you can also download and install 
a recipients’ key individually from DISA GDS (DOD 411) then add them 
to your Contacts list. For assistance please contact your IT support 
provider. It is possible to send encrypted from army.mil to army.mil. 

How do we overcome these challenges? ALL Army users migrate 
to Army 365 Exchange Online (EXO) Email.

Using A365 EXO Email During Transition

https://dod411.gds.disa.mil/
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Final Steps:
a) Verify that the email redirect from mail.mil to 

army.mil is functional.  

b) Verify that all historical data (emails, 
calendars, contacts, rules) has been 
imported to your army.mil mailbox

c) Connect mail.mil mailboxes and calendars 
that have not migrated to army.mil yet and re-
add PST files in Outlook

Now you are ready to finalize migration by deleting your 
DEE mailbox. If you are a DMUC iPhone user this step will 
also trigger the transition in the Email+ app. 
If you cannot verify or complete any of the three steps 
above please consult your IT service provider or an Army 
365 Champion for assistance.

To begin, navigate to the EXO Migration Portal’s Self-
Submission for DEE Deletion Page. Scroll to the bottom of 
the page and click the Big Green Button to submit for 
deletion. Input your DEE Address, your MACOM, your 
Customer Code, and certify the submission, then click 
Save. See schedule to the right to determine when your 
DEE / mail.mil will be deleted.

Self-Migration: Delete DEE Mailbox (Completion!)

Direct Link:  https://armyeitaas.sharepoint-
mil.us/teams/EXOMigration/SitePages/Self-
Submit-for-DEE-Deletion--Info-Page.aspx

You can double-check preparedness using the 
Self-Migration Checklist or watch the video 
walkthrough to review the major steps.

The timer indicates the cut-off for the next 
weekly migration window.

The DEE Deletion Schedule:

Submissions before 1700 EST every 
Monday are added to the queue for 
DEE deletion to occur 2 days later on 
Wednesday, between 0730 EST and 1700 
EST.

Submissions after 0900 EST every Monday 
are queued for the following Wednesday 
(9 days later).

https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/SitePages/Self-Submit-for-DEE-Deletion--Info-Page.aspx
https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/SitePages/Self-Submit-for-DEE-Deletion--Info-Page.aspx
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*SKIP THIS PAGE IF YOU ARE SELF-MIGRATING*

If you are presented with “Error 500: Something went wrong. We couldn’t find a mailbox for this 
account…” when attempting to access https://webmail.apps.mil then you are unable to Self-Migrate and 
will need to submit for Assisted Migration. This process involves an automatic transfer of existing DEE 
mailbox data to a new A365 EXO mailbox. To best prepare yourself for success you should review and 
complete the Mailbox Cleanup steps in the links below. 

Attachments Cleanup Calendar Cleanup Redundant Threads Cleanup

Once your DEE mailbox has been cleaned you can submit for Assisted Migration on the 
EXO Migration Portal’s Assisted Migration Submission Page. Input your DEE Address, your MACOM, your 
Customer Code, and certify the submission, then click Save.  See schedule below to determine when your 
DEE / mail.mil will be deleted.

Note: When Assisted Migration occurs you may experience interruption in email access for 1-3 hours. 
Once Outlook indicates the mailbox has been removed please follow steps in the DEE to EXO TTP in 
order to add your new A365 mailbox in Outlook.

Assisted Migration: Automated Transfer of DEE to EXO

The Assisted Migration Submission Schedule:

Submissions before 1700 EST every Monday are added to the queue for Assisted Migration to 
occur three days later on Thursday, between 0730 EST and 1200 EST.

Submissions after 0900 EST every Monday are queued for the following Thursday (10 days later).

https://webmail.apps.mil/
https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/Shared%20Documents/Outlook%20Cleanup%20-%20Attachments.pdf?web=1
https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/Shared%20Documents/Outlook%20Cleanup%20-%20Calendar.pdf?web=1
https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/Shared%20Documents/Outlook%20Cleanup%20-%20Redundant%20Threads.pdf?web=1
https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/Lists/Assisted%20Migration_SelfSubmission/NewForm.aspx?Source=https%3a//armyeitaas.sharepoint-mil.us/teams/EXOMigration/Lists/Assisted%2520Migration_SelfSubmission/AllItems.aspx&ContentTypeId=0x0100149901639ADB324BA136FD9E0052659F006379E37FF26FA24EAE6C081A87ED2798&RootFolder=/teams/EXOMigration/Lists/Assisted%20Migration_SelfSubmission
https://armyeitaas.sharepoint-mil.us/:b:/t/Army365HowToGuides/EWYuj0aNem5JiCuvmQr2SJQBYgZT3u9oOg7mq0DzXmpzbA?e=pGR6id


UNCLASSIFIED

For further info on EXO Migration, including:  instructions, email migration submissions, 
and support, please visit the EXO Migration SharePoint Portal: 

https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/

The EXO Migration Portal

https://armyeitaas.sharepoint-mil.us/teams/EXOMigration/
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